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Overview of Schedule
Schedule automatically launches unattended WebSeeker searches. You can use this utility to run long, complex searches 
during the night when connection rates are lower. In addition, Schedule can start up any program or macro, at a specified time 
or at regular intervals. For example, you could use it to automate backups. Schedule is an easy program to use; all you do is set
the time, date, and full name and path of the program to launch. As long as the Schedule program is running (normal, minimized
or hidden), it launches your program at the specified time. Schedule can also Print files.

If you plan to use Schedule for Daily, Weekly, or regular program launching, you should load program automatically when you 
run Windows by adding it to your Start Menu. When you add Schedule to your Start Menu, you must have the SQD file loaded 
that you want Schedule to run.

The program is designed to run under Windows 95, and Windows NT and use a minimal amount of time on the Central 
Processing Unit. You may set the frequency for which the computer checks for a program to launch. The recommended time is 
100 (1 second). With the default setting, you will probably not notice any slowdown on the system. If your computer experiences 
any slowdown, or your operations are not time critical operations, you may want to increase the number.

Click the Schedule button to learn to schedule a program to launch, or the Start Menu to add Schedule to 
your Start Up group.



A Quick Tutorial of Schedule

    Lesson One: Scheduling a New Action

    Lesson Two: Opening a Schedule (SQD) File

    Lesson Three: Adding to a Schedule

    Lesson Four: Editing a Schedule

    Lesson Five: Command Line Functions



Lesson 1: Scheduling a New Action

1.          First, launch Schedule.

¨ Double click the Schedule icon  from Windows Program Manager or Windows Explorer. 
¨ You can also access Schedule from WebSeeker by selecting Schedule from the Search menu. 
¨ The Schedule window appears.

    If you have opened Schedule from WebSeeker the WebSeeker search file will already be added to the new Schedule file 
(SQD).

2.          Now add an action to Schedule.

¨ Select Add from the Configure menu.
¨ The Add/Edit dialog box appears.

Click on the dialog box below to learn more about each option.



3.          Set Schedule options.

¨ Enter the configurations and program or macro desired, and click OK.

The action has been added to the new Schedule file.

¨ Add more actions as desired.

4.          Save the File.

¨ When you have finished adding actions to the SQD file select Save As from the File menu.
¨ Enter a name for the file, and press OK.

Schedule will automatically perform the action at the time and date specified.

    NOTE:    Schedule must be running in order to execute any scheduled action!

Click Add to Start Up to learn how to add Schedule to your Windows Start up Group.
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Add Schedule to Start Up Group

1.          First display the Start Menu.

¨ Click the Windows Start     button to display the Start Menu.

2.        Open Taskbar Properties

¨ Select Settings, Taskbar.
¨ The Windows Taskbar Properties dialog box    appears.



3.          Create a Shortcut.

¨ Select the Start Menu Programs    tab, and click Add.
¨ The Create Shortcut dialog box appears.

4.          Enter the drive, directory and file name for Schedule.



¨ By default Schedule will be installed to:
¨ C:\Program Files\ForeFront\WebSeeker\Sched32.exe.
¨ When you have entered the file and location press Next.
¨ The Select Program Folder dialog box appears.

5.          Add to Folder.

¨ Select the StartUp folder and press Next.
¨ The Select a Title for the Program dialog box appears.

6.        Finish.

¨ Press the Finish button.
¨ Press OK on the Taskbar Properties dialog box to close it.
¨ The Schedule program has been added to your StartUp group.



Lesson 2: Opening a Schedule (SQD) File

1.          Opening a file from Schedule.

¨ Launch the Schedule program.
¨ Select Open, from the File menu. The Open File dialog box appears.
¨ Enter the name and location of the SQD file you wish to open. If you do not know the name and location of the file 

use browse to find it.
¨ Press the Open button. Schedule opens the selected file.

2.          Opening a file from Windows Explorer or Program Manager

¨ Start Windows Explorer or Program Manager.
¨ Locate the file you wish to open and double click it.
¨ The Schedule program is launched and will open with the selected file.
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Lesson 3: Adding to a Schedule

1.          First open a Schedule file.

¨ Start Schedule.
¨ Select Open from the File menu.
¨ Enter the name and location for the file you would like to open. If you don’t know the name and location of the file 

use the Browse button to find it.
¨ Press the Open button.

2.        Add the new action.

¨ Select Add from the Configure menu.
¨ The Add/Edit dialog box appears.

Click on the dialog box below to learn more about each option.

3.          Set Schedule options.

¨ Enter the configurations and program or macro desired, and click OK.

The action has been added to the active Schedule file.

¨ Add more actions as desired.

4.          Save the File.

¨ When you have finished adding actions to the SQD file select Save from the File menu, and press OK.
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Lesson 4: Editing a Schedule

1.          Open the SQD file you would like to edit.

¨ Start Schedule.
¨ Select Open from the File menu.
¨ Enter the name and location for the file you would like to open. If you don’t know the name and location of the file 

use the Browse button to find it.
¨ Press the Open button.

2.          Make desired modifications

¨ Select the action you wish to modify. Selected item will be highlighted.
¨ From the Configure menu select Edit. The Add/Edit dialog box appears.
¨ Make desired changes to the action and press OK.
¨ Make modifcaitons to other actions as desired.

3.      Save the modified file.

¨ When you have finished making modifications, select Save from the File menu.
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Lesson 5 Command Line Options
Command line options are entered in the Command Line field of the Add/Edit dialog box. The following command line functions 
are available:

Command Function

/e Exit upon completion

/u Unattended search.

These options should be entered after the location and file name to be executed, with one space in between. For example:

c:\Program Files\ForeFront\WebSeeker\Webseeker.exe /e

When using the /u option to perfrom an unattended WebSeeker search you must specify the WSK file to be launched. The file 
name and location should be listed in parentheses. For example:

c:\Program Files\ForeFront\WebSeeker\Webseeker.exe /u “c:\Windows\FastCars.WSK”
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Select month, day, and year to begin the action here.



Select the time to begin the action here.



Select the frequency for the action to be performed here.



Select month, day, and year to end the action here. This option is only enabled if the frequency has been set for more than once.



Select the time to end the action here. This option is only enabled if the frequency has been set for more than Once.



Enter the description of the action to be scheduled here. This field is optional.



Enter the directory and file to be scheduled here.



Enter the directory to save file to (if applicable). This is an optional field.



Select the Run Mode desired here: Normal; Minimized; Maximized.



Check here to have Schedule print the SQD file upon completion.



Check this box to have Schedule execute the scheduled program in the background. This option is not available if run mode is 
set to Maximize.



Click here to   browse   for file to execute.



Click Cancel to discard any changes and abort current action.



Click OK to accept current configuration and add item to the current SQD file.



Click the Help button at any time to open the Schedule help file.



Menu Commands

 File Menu     Configure Menu

 Edit Menu     Help Menu



File Menu
Use the File menu to create, open and save SQD files, and to exit Schedule. To learn more about each option 
check on the menu below.



File Menu
Edit Menu
Configure Menu
Help Menu



Creates a New SQD file.



Opens an already existing SQD file. The Open File dialog box appears.



Saves the active file.



Saves active Schedule to an SQD file named by the user.



Exits Schedule.



Edit Menu
Use the Edit menu to cut, copy and paste selections. To learn more about each option click on the menu below.



File Menu
Edit Menu
Configure Menu
Help Menu



Cuts the selection.



Copies the selection to the Clipboard.



Pastes Clipboard contents at point of insertion.



Configure Menu
Use the Configure menu to add or edit actions, to change personal and run settings, and to test SQD file for 
functionality. To learn more about each option click on the menu below.



File Menu
Edit Menu
Configure Menu
Help Menu



Adds an action to the active SQD file.    The Add/Edit dialog box appears.



Edits the selected action. The Add/Edit dialog box appears.



Deletes the selected action from the active SQD file.



Launches Scheduled activity(ies) in active file immediately to test for functionality.



Lets you change the frequency that Schedule uses to check for actions that need to be run. The Schedule Settings dialog box 
appears.



When this option is checked (default) Schedule  will warn you if a specified file is not associated with any application. You will 
get this warning when you add a file that has no association and when Schedule attempts to run a command line that has no 
association.

To associate a file extension with a program, select the program and choose Associate from the File menu in the Program 
Manager, or Open With File from Windows Explorer.



When selected this option will hide the Schedule icon during minimized run. Schedule will not appear in the taskbar.
    NOTE: If the Schedule icon is hidden you will be unable shut down Schedule.



Help Menu
Use the Help menu to get assistance on Schedule and Winhelp, and to display version and copyright 
information.



File Menu
Edit Menu
Configure Menu
Help Menu



Launches the Schedule help file to the contents page.



Launches the Schedule help file to the Index.



Launches Windows Winhelp help file.



Displays copyright and version information.



Utilities
The following utilities are available for use with Schedule. Click on each one to learn more about it.

    Grab-a-Dial
    Don  ’  t Stop  
    Hang-it-Up



The OR operator is often used to include two different phrases of a Boolean search. For example, using the keywords "plane" 
and "airplane,” select OR as the Boolean Operator. WebSeeker now searches for all documents containing either the word 
"plane,” OR the word "airplane,” OR both. This expands your search to include documents that might not otherwise be found. An
article that only uses the word "plane" would not be found while searching for just "airplane."



AND is a search option that links keywords together for the search. When AND is selected WebSeeker looks for documents 
containing all of the keywords listed.



Boolean Operators
When adding Searches, you have the option to choose a Boolean Operator. The WebSeeker Start New Search dialog allows 
you to select the AND operator by checking the AND words together radio button. If you don't use the AND operator, you are 
using the OR operator by default. Some Search Engines have additional operators or other search options. To use the specific 
options for each individual Search Engine, right-click on the Search and select Properties. A dialog box specific to the selected 
search appears. To learn more about these individual Search Engine options, go to the Home page for the Search Engine.



Glossary

A

Acceptable Use Policy (AUP)
Address
Alias
Anonymous FTP
Application
Archie
Archive
Authentication

B

Boolean Operators
Bounce
Browse
Browser
Bulletin Board System

C

Chat
Client
Compact Database
Cracker
Cyberspace

D

Data Encryption Key (DEK)
Data Encryption Standard (DES)
Datagram
Dedicated Line
Dialup
Domain
Domain Name System (DNS)



E

Electronic Mail (Email)
Encryption
Ethernet

F

FAQ (Frequently Asked Questions)
File Transfer Protocol (FTP)
Firewall

G

Gateway
Gopher

H

Hacker
Home Page
Host
Host Address
Host Name
Hypermedia
Hypertext
Hypertext Markup Language (HTML)

I

InstantUpdate
Integrated Services Digital Network (ISDN)
Internet
Internet Protocol (IP)
Internet Protocol Address (IP Address)
Internet Service Provider (ISP)
IRC

J

Jughead

K

Kermit



L

LAN
Launch
Leased Line
Log-off
Log-on
Login
Lurking

M

Mailing List
Mirror Site

N

Netiquette
Network File Systems (NFS)
Network News Transfer Protocol (NNTP)

O

Open System Interconnection (OSI)

P

Packet
Packet Internet Gopher (PING)
Point of Presence (POP)
Point to Point Protocol
Port
Post Office Protocol (POP)
Posting
Protocol
Proxy
Proxy Server

Q

Quit

R

Radio Buttons



Realtime
Renew
Reposts
Router

S

Search Result
Search
Search Module
Serial Line Internet Protocol (SLIP)
Server
Signature
Simple Mail Transfer Protocol (SMTP)
Simple Network Management Protocol (SNMP)

T

T1/T3
TCP/IP Stack
Telnet
Token Ring
Transmission Control Protocol/Internet Protocol (TCP/IP)

U

Universal Resource Locator (URL)

V

Veronica

W

Webmaster
Web Page
Whack
White Pages
Winsocks
World Wide Web (WWW or W3)

X, Y, Z

X-Axis
X-Y-Matrix
Y-Axis



 Acceptable Use Policy (AUP)
This refers to policies restricting the ways in which a network may be used. It is usually the network administrator who makes 
and enforces decisions dealing with acceptable use.



 Address
See either IP Address or Email Address. 



 Alias
A nickname (usually short and easy to remember) that is used in place of a type of network resource. Aliases are used so you 
won't have to remember the long and difficult names typically associated with network resources.



 Anonymous FTP
Most FTP sites offer limited access by using the word "anonymous" as your user ID, and your E-mail address as the password 
when you login This way you can bypass local security checks and access to public files on the remote computer.



 Application
Often referred to as a client or an "app," it is a program that performs a specific function. The most common examples of Internet
applications    are, FTP, Mail, Gopher, Mosaic, and Telnet clients.



 Archie
The term “Archie” is often heard as an “Archie search”. Archie is a way of automatically collecting, indexing and sometimes even 
retrieving files on the Internet. Once you have located the information you are looking for, a good Archie client is able to FTP the 
files. 



 Archive
An archive is a collection of files stored on an Internet machine. FTP sites are known as archives.



 InstantUpdate
A ForeFront program which automatically upgrades to the newest version of WebSeeker.



 Authentication
A security process that ensures that users are who they say they are. When you type your name and password, you are 
authenticated and allowed access.



 Bounce
Bouncing occurs when you send an E-mail message and it doesn’t make it to the intended recipient, for any reason. The 
message “bounces” back to you. A bounced message usually begins with something like: “Undeliverable Mail” or “Message 
Undeliverable.”



 Bulletin Board System (BBS)
A computer which typically provides E-mail services, file archives, and announcements of interest to the bulletin board system's 
operator (known as a sysop). BBS's started out as hobbies for computer enthusiasts, and were mostly accessible by modem. 
Recently, however, more and more BBS's are being connected to the Internet. 



 Chat
An acronym meaning "Conversational Hypertext Access Technology." Another term for IRC.



 Client
An application that performs a specific function, such as Telnet or FTP. In more general terms, a client is an application that 
request the service of another computer, or application. A workstation requesting the contents of a file from a server is known as 
“Client Server Architecture”.



 Cracker
Unlike the benign “hackers,” crackers are usually malicious in their intentions. They are users who try to gain illegal access to 
computers.



 Cyberspace
William Gibson referred to Cyberspace in his fantasy novel “Neuromancer” as the “world of computers and the society that 
gathers around them,” Cyberspace has become a loose term for the on-line world, and sometimes the Internet.



 Data Encryption Key (DEK)
DEK’s are used like an actual key, to lock and re-open doors. They are used for the encryption and decoding of message text to 
limit access to those with the DEK.



 Data Encryption Standard (DES)
The standard Internet encryption method.



 Datagram

A block of data carrying enough information to travel from one Internet site to another ”non-stop”. In simple terms, it is “smart” 
enough to move around multiple sites without having to rely an earlier exchanges between source computers nad destination 
computers.



 Dedicated Line
A communications line that is used solely for computer connections. If you buy an additional phone line for your modem, that's a 
dedicated line. There are other types of dedicated lines (such as T3s and T1s) that are used for larger network entities. 



 Dialup
A widely-used method of accessing the Internet. A dialup connection uses regular phone lines to connect one computer to 
another via modem.



 Domain
Technically, the alphanumeric part of the DNS naming system; it is usually identifiable as a series of words separated by periods 
(called dots). For example, ffg.com is pronounced ffg-dot-com. In general terms, a domain is a logical region of the Internet and is 
commonly referred to as a site.



 Domain Name System (DNS)
Database system used to map the meaningful names humans use to refer to machines on the Internet (such as, The ForeFront 
Group) onto the IP addresses that the computers use to access one another. DNS allows the user to type in a simple, 
memorable company name which the computer converts into a unique series of numbers.



 Electronic Mail (Email)
A common way in which    computer users can exchange messages with each other over a network, or the internet. In fact E-mail
is probably the most widely used communication tool used on the Internet. E-mail has it’s own quirky language, but most 
conventions entail “To:”, “From:”, and “Subject:” lines. One of e-mails advantages is its ability to be forwarded and replied to 
easily.



 Email Address
An E-mail address has several different elements. Conventionally, addresses use lovercase letters with no spaces in between 
letters. The first part of the address is the username, which identifies a unique user on a specific server. Nest there is generally 
an “@”, (pronounced "at"). The “@” separates the username from the host name. The last part of an E-mail address is the Host 
name which uniquely identifies the server computer. For example, my E-mail address is:

sharone@ffg.com

Larger servers like those used at most universities, or large companies, often contain multiple parts, called subdomains. The 
subdomains and the host name are separated by a “.” (pronounced “dot”). The subdomain follows the host name. A two or three-
letter suffix represents the subdomain, and identifies the kind of organization operating the server. Some common suffixes 
are: .com (commercial) .edu (educational) .gov (government) .mil (military) .net (networking) .org (non-commercial). Two-letter 
suffixes are often used outside the U.S. to identify the country in which the server is located. Some examples are: .jp (Japan) .nl 
(The Netherlands) .uk (United Kingdom) .ca (Canada) .tw (Taiwan).



 Encryption
The basis of network security. Encryption encodes network packets to prevent anyone except the intended recipient from 
accessing the data.



 Ethernet
A standard and widely used connection type for Local Area Networks (LANs). Ethernet can transfer information at speeds of up 
to 10 Megabit-per-second (Mb/s).



 FAQ (Frequently Asked Questions)
Acronym for “Frequently Asked Questions.” FAQs are widely available on the Internet, usually in the form of large text files. 
FAQ’s can be written on any subject. they are frequently used in software documentation to resolve common problems. FAQ’s 
often provide the up to date, and easily accessible information on a their spcific subjects.



 File Transfer Protocol (FTP)
(File Transfer Protocol) TCP/IP protocol for transferring (copying) from one machine on the Internet to another. Basically, it is the 
Internet version of the File Copy functions on most desktop platforms. Since FTP evolved on the UNIX platform, its commands 
for making and changing directories, transferring, copying, moving, and deleting files were originally rather arcane text-based 
commands typed at a prompt. Fortunately, many graphical applications are now available that make FTP commands as easy as 
dragging and dropping.

 



 Gateway
A kind of "go-between" device or program that passes information between networks that normally couldn't communicate. What 
used to be called a gateway is now called a router. Not to be confused with a protocol converter. 



 Gopher
A gopher is an Internet information search and retrieval tool, used widely for research. The information that gopher retrieves is 
stored hierarchically on computers across the Internet. It uses a simple protocol that allows clients to access information from a 
multiple Gopher servers at once, creating what's known as "gopher space." Jughead and Veronica are the most common search 
tools used in gopher. Gopher clients exist on most platforms. 



 Hacker
A computer user who interested in gaining a complete understanding of the "ins and outs" of computers, networks, and the 
Internet in general. The term is meant to imply a tedious hacking away in bits and bytes. Hackers are usually benign, unlike their 
counterparts, crackers. 



 Host
A central computer or server that is attached to a network or the Internet. Hosts machines are set up for information sharing and 
file transfers. Individual users communicate with host machines by using client application programs. A Host can be a large 
server, or a mainframe, or even a desktop PC that is set up to share information to it’s peripherals.



 Host Address
The E-mail address of a host computer on the Internet. 



 Host Name
The name given a host computer connected to the Internet.



 Hypermedia
Hypermedia combines the elements of hypertext and media in one document. 



 Hypertext
A type of text containing “hot” or embedded "links" to other documents, or other pages within the same document. Clicking on or 
selecting a hypertext link “jumps” to display another page in another document or document section. Most World Wide Web 
documents contain hypertext.



 Hypertext Markup Language (HTML)
The standardized    way of marking text documents for publishing on the World Wide Web. HTML is marked-up using "tags", or 
context strings, surrounded by brackets. 



 Integrated Services Digital Network (ISDN)
A fairly new technology combining voice and digital network services. ISDN allows communications carriers to offer their 
customers digital data services and voice connections through a single line.



 Internet
A large computer network consisting of other smaller networks across the world. There are over 40,000 interconnected networks 
spanning at least 70 different countries. The Internet, which was originally created for military purposes, has become a highly 
commercialized information highway.



 Internet Protocol (IP)
A connectionless industry standard packet switching protocol used as the network layer in the TCP/IP Protocol Suite.



 Internet Protocol Address (IP Address)
The 32-bit address defined by the Internet Protocol. Every resource on the Internet has a unique numerical IP address, 
represented in dotted decimal notation. IP addresses are the closest thing the Internet has to phone numbers. When you "call" 
that number (using any number of connection methods such as FTP, HTTP, Gopher, etc.) you get connected to the computer 
that "owns" that IP address.



 Internet Service Provider (ISP)
An ISP is a company that maintains a network that is linked to the Internet through a T1 or other dedicated line. Individuals can 
purchase access to the Internet from the service provider.



 IRC
An acronym for Internet Relay Chat. It is Internet computer conferencing. There are hundreds of different IRC channels on 
almost every imaginable subject, from over 60 countries. You can join a chat group and enter messages that are broadcast to all 
members of that group.



 LAN
Acronym for "Local Area Network." A LAN is a communications network serving people within a certain area, such as a business.
LANs allow users to send E-mail and share resources such as files, printers, modems, etc. Many large companies now connect 
their LAN’s to the Internet so that they can access resources from outside their own network.



 Leased Line
A private, dedicated, full-time, communications channel used to link a user, or network to an Internet Service Provider or another 
network.



 Lurking
Lurking is non active participation in an IRC or Internet newsgroup. Essentially it is eavesdropping on the active participants. 
Lurking around a discussion group is a good way to catch up with the discussion, and also the acceptable behavior of the group.



 Mailing List
A list of E-mail addresses you can use to send “bulk” E-mail, instead of writing the same message over and over. You can also 
subscribe to an Internet mailing list on many subjects. After you have subscribed to a mailing list, you receive all mail sent to that 
list. 



 Mirror Site
Many Web and FTP sites have become so popular that they have acquired “mirror sites” to alleviate congestion. Mirror sites are 
areas on another computer that “mirror” or contain an exact replica of the directory structure of the files on the overly popular 
site’s computer. If you have trouble getting connected to an FTP site, for example, because of the high amount of traffic, you can 
usually connect to a mirror site that contains the same information on a different computer. Mirror sites are usually updated once 
a day.



 Netiquette
Netiquette is a combination of the words “network” and “etiquette”. Netiquette defines appropriate behavior on a network, or the 
Internet. It was developed to remind users that there are real people on the other end of the connection, and that certain 
comments are considered unacceptable.



 Network File Systems (NFS)
A distributed file system developed by Sun Microsystems. NFS allows information and file sharing across multiple platforms. This
de facto UNIX standard makes remote files appear as if they are on a local machine.



 Network News Transfer Protocol (NNTP)
A standard protocol used for Usenet groups on the Internet. NNTP regulates    the distribution, inquiry, retrieval, and posting of 
news articles. NNTP is supported Usenet newsreaders.



 Open System Interconnection (OSI)
A standard developed by the International Standards Organization for worldwide communications. OSI defines a framework for 
implementing protocol in seven layers, designed to be the international standard computer network architecture. 



 Packet
The common term for a block of data transmitted across the Internet. 



 Packet Internet Groper (PING)
Ping is an Internet utility used to    test or, time the response of an Internet connection. After the message , or PING, is sent out, 
you wait for a response (or PONG).



 Point of Presence (POP)
POP is the point at which a long distance carrier and a local carrier, or user, connect. 



 Point to Point Protocol
A datalink protocol providing dial up access over serial lines. It encapsulates other standard protocols (such as IPX, TCP/IP, and 
Netbeui) over a standard telephone connection, but it can also be used for LAN connections.



 Post Office Protocol (POP)
A protocol commonly used by E-mail programs to transfer messages to and from file servers via the Internet. When E-mail is 
sent to you, it is stored on the server until accessed by you. Once you have logged in and your password is verified, the POP 
transmits the stored mail from the server to your local mailbox on your computer.



 Posting
The sending of an article to a Usenet newsgroup or the placing of a message on a BBS.



 Protocol
Language spoken between computers to exchange information. More technically, a protocol is the formal description of formats 
and rules followed by machines to exchange information. Different protocols are used to exchange different sorts of messages, 
such as news for newsgroups and FTP for file transfers.



 Router
A device that forwards traffic between networks. Forwarding decisions are made based on network layer information and routing 
tables, often constructed by routing protocols. 



 Serial Line Internet Protocol (SLIP)
Similar to PPP, SLIP is another standard protocol used to run TCP/IP over serial lines, such as telephone circuits or RS-232 
cables. Unlike PPP, however, SLIP does not work on a LAN connections. SLIP is probably the most popular way for dialup users 
to access the Internet.
Standard protocol (similar to PPP) which is used to run TCP/IP over serial lines, such as telephone circuits or RS-232 cables. 
SLIP, unlike PPP, does not work on LAN connections. SLIP is one of the most popular ways for dial-up users to access the 
Internet. In general, Web access requires a SLIP or PPP connection.



 Server
Simply, a computer that provides resources, such as files or other information, to multiple users. Servers act like a remote disk 
driver.



 Signature
A unique number, or identifier in ASCII format that can be embedded in to a piece of E-mail or newsgroup posting that identifies 
the sender.



 Simple Mail Transfer Protocol (SMTP)
A simple messaging protocol used to transfer E-mail. SMTP is used in TCP/IP networks to transfer mail from server to server.



 Simple Network Management Protocol (SNMP)
A commonly used protocol for network monitoring and control. It can be used to manage wiring hubs, CD ROM jukeboxes, and 
many other devices.



 T1
Two terms coined by AT&T to describe the types of high-speed connections of hosts to the Internet. A T1connection transmits a 
DS-1 formatted digital signal at 1.544 megabits per second. A T3 connection transmits a DS-3 formatted digital signal at 44.746 
megabits per second.



 TCP/IP Stack
To properly implement TCP/IP protocol, PCs require a TCP/IP stack. This type of network architecture is designed in layers (OSI 
and SNA are also considered stacks).



 Telnet
The Internet standard protocol used to connect to remote terminals. Telnet allows users to log onto a remote terminal or    
computer and run a program, as if it were local. Telnet clients are available for most platforms.



 Token Ring
A type of LAN in which allows up to 255 network computers (nodes) to be wired into a "ring." Each computer is in constant 
contact with the next node in the ring. If one node in the ring loses it’s connection, each following link in the network is disabled.



 Transmission Control Protocol/Internet Protocol (TCP/IP)
TCP/IP is the standard communications protocol created under contract from the U.S. department of defense. Originally created 
to internetwork dissimilar systems, TCP/IP is now required for Internet computers. Everey computer attaching to the internet 
needs a set of software components call a TCP/IP stack.



 Veronica
A search engine (similar to Archie) that is embedded into Gopher. Veronica allows searches of all gopher sites for files, 
directories and other resources. 



 Universal Resource Locator (URL)
Standard address format used to identify and locate sites on the Internet. World Wide Web site URLs begin with the prefix http:// 
(HyperText Transfer Protocol), generally followed by www (World Wide Web). After the standard prefixes, URLs use identifiers for
different domains and subsections of domains, each separated by a period (.). The various levels of a site are separated by a 
forward slash (/); individual home pages are often preceded by a tilde (~).



 White Pages
Similar to a telephone book, White Pages referes to a database containing E-mail addresses, telephone numbers, and postal 
addresses of Internet users. You can search the Internet White Pages for information about particular users.



 Winsocks
A combination of the words "Windows” and “Sockets." Winsocks is a common programming interface between the TCP/IP 
protocol and a Windows application.



 World Wide Web (WWW or W3)
The "Web" is a collection of online documents interconnected through hypertext links on Internet. These hypertext/hypermedia 
documents, or Web pages, reside on different servers all around the world. On the WWW you can “jump” from one document to 
the next no matter where it is located in the world. In order to access these documents, you must use a Web browser, such as 
Netscape, Microsoft Internet Explorer, or Mosaic.



 Browser
A program that lets the user look through data. Examples of common Internet browsers are: Netscape, Microsoft Internet 
Explorer, Mosaic, etc.



 Browse

1- To view a group of files or the content of a single file. A browser program allows you to scroll through documents or databases.

2- Browse buttons allow you to view the file names in your disk directories.    Clicking on the name of a drive or directory 
automatically switches you to those locations



 Home Page
Point of entry into a company’s, individual’s, or institution’s set of HTML pages on the World Wide Web. This foundation page is 
often used as an index with links to other resources on the Web or to other Internet servers.



 Search
To look for specific of data or text.



 Search Result
The findings returned on a Search.



 Search Module 
A Search Module is what allows WebSeeker to interface with the Search Engines.



 Web Page
A page of a document on the World Wide Web.



 Webmaster
The person responsible for creating a Web Page, and keeping it updated. A Webmaster would be the equivalent to a system 
administrator on the World Wide Web.



 Jughead
An Internet utility which will perform a keyword search on all levels of a Gopher menu. Using Jughead you do not have to jump 
from one level of the menu to the next.



 Kermit
Kermit is an asynchronous file transfer protocol which was developed at Columbia University. Kermit is known for it’s accuracy 
across noisy lines.



 Launch
To load and run a program.



 Log-On
To sign on, or gain access to a computer system. Some systems may require user identification and a password.



 Log-Off
To sign off, or disconnect from a computer system.



 Quit
To exit an active application.



 Radio Buttons
Circular on-screen buttons that are used to select one out of several responses. A small black spot will appear in a radio button 
when it is selected. A radio button becomes de-selected when another within the same “box” or section, is selected.



 Realtime
An immediate response. Any electronic response system fast enough to keep up with it’s real world counter parts.



 Renew
Launches a search of a previously completed search.



 X-Axis
This refers to the horizontal rows in an X-Y Matrix.



 Y-Axis
Y-Axis refers to the vertical columns in an X-Y matrix.



X-Y-Matrix
A group of rows and columns. The reference framework for 2 dimensional structures.



Login
Same as log-on.



Firewall
Network node used as a boundary, or security device, to prevent Internet traffic from crossing over from one side to another. A 
firewall may be implemented in a router protecting a company’s or institution’s server, or it may be a specialized device used for 
such purposes.



Proxy Server
Application which passes information between a browser and the Internet. A proxy server is used to get through a firewall. A 
proxy can only be used one way through the firewall. If your server has a firewall a proxy server is used to get through the 
firewall out to the Internet. 



Port
A pathway or opening into and out of a computer. 



Reposts
Each search engine has a maximum number of results it can display at a time. If you want to see more information you can 
repost and the next set of results will be displayed.



Compact Database
Deletes items that have been tagged for deletion and recompiles data.



Boolean Operator

Boolean logic, named for 19th century English mathematician George Boole, uses AND, OR, and NOT as its primary operations,
just as add, subtract, multiply, and divide are primary operations of arithmetic.

A Boolean search requires that specific conditions must be met. For example, using the keywords “tropical fruits,” the AND 
Boolean operator requires that both words “tropical” and “fruits” be contained in the data of a matching result.



Whack

Downloads the web page where the keyword was found to the computers hard drive so results can be viewed later. Grab copies 
the results in HTML format so that you can surf the results on your hard drive.



NOT is a Boolean operator available using the Refine tool. Using NOT as the search operator will exclude any words listed in 
parallel with NOT from the document. For example, using the keywords “fruit” but NOT “tropical” would exclude any documents 
that contain the word “tropical”.



Proxy

Special kind of application which serves as an interface between the Web browser and the actual connection to the Internet. 
WebWhacker is a proxy (or proxy server) which serves up information from the WebSeeker User’s Manual database to your Web
browser.




